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Chapter 1              

                           Introduction 

  
The project aims at studying the structures of some proteins of biological 

importance through 3D visualizations using the free and open-source software  

Jmol and UCSF Chimera. Jmol has a wide application in the visualization of 

chemical molecules, animations of chemical reactions, crystal structures, and 

biomolecules. 

It allows users to create 3D models of the molecules of their interest and aids in the 

study of stereochemical aspects, bond lengths, bond angles, etc. It is a powerful 

educational tool that makes students understand the structures of a molecule. The 

3D models made using this application can also be incorporated into websites and 

blogs. It has a profound use, especially in the visualization of larger molecules 

which are made up of thousands of atoms. This application helps the user to view 

the model in a much clearer manner. The provision to rotate and view the molecule 

from different points provides a better understanding of the studies of the molecule.  

 

UCSF Chimera is a software that is dedicated to the structural studies of biological 

molecules. The software has provisions to overlap and study the difference between 

two biomolecules. It also displays the sequence of amino acids in the case of proteins 

and constructs an isosurface based on the electrostatic potentials of the amino acids 

present. The software also helps its user to view the Ramachandran plot for protein 

molecules.  

 

In this project, the Jmol application is used in the construction of webpages on 

Myoglobin and Hemoglobin, Proteases, and proteins involved in the respiratory 

transport chain.  UCSF Chimera is used to study the difference in the amino acid 

sequence of normal deoxyhemoglobin and sickle deoxyhemoglobin. 

 

The version of Software used:   

Jmol - 16.1.11 

UCSF Chimera - 1.17.1 
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Chapter 2     

                 General Description of Proteins 

 
2.1 Introduction: 

Proteins are the polymers of amino acids linked by amide bonds known as peptide 

bonds. Proteins play a number of roles as catalysts, structural support, and in the 

energetics of any organism. They contain more than 100 amino acids and have a mass 

higher than 10,000 Da. 

The proteins can be described into 4 different types of structure – Primary, Secondary, 

Tertiary, and Quaternary structures. 

Among these, the 3D Modelling using the UCSF Chimera and Jmol depicts the 

secondary and tertiary structure of protein fed. 

 

2.2 Determination of protein structures: 

About 90% of the structure of proteins present in the protein data bank is determined 

from the X-Ray diffraction studies done using the protein macro crystals of about 

50µm. The diffraction pattern obtained from the X-Ray diffraction is used for electron 

density mapping and thereby generating the protein model. 

  

Source: Principles of Biochemistry, 4/e © 2006 Pearson Prentice Hall Inc. 

Fig 2.1 Depicts the construction of a molecular model from the electron density map obtained using 

an X-Ray diffraction pattern 
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2.3 Ramachandran Plot: 

It is a plot between the phi angle (the angle around the -N-Cα- bond) and the psi angle 

(the angle between the -Cα-C- bond) of the amino acids present in the protein that are 

sterically permitted. The plot was developed by the Indian Biochemist, Dr. G. N. 

Ramachandran in 1963. 

The plot had 4 quadrants where the population of amino acids correspond to particular 

secondary structures based on the steric hindrance. The blank space in the plot denotes 

non-permissible angles based on their energy levels. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Fig 2.2 Ramachandran plot - The values of phi and psi for various allowed secondary structures are 

represented. 

 

 

 

 

 

 

 

 

 



7 
 

 

Chapter 3 

       Globins - The Oxygen Binding Proteins 

3.1 Myoglobin – The Oxygen Storage 

                     Myoglobin is a monomeric heme-containing protein found in almost 

all mammals. It is used in oxygen storage and is responsible for the red color of 

muscles due to the presence of Iron as its central metal ion. 

Myoglobin has two components: - 

1. A Polypeptide chain with 153 amino acids 

2. Heme – A cyclic tetrapyrrole consisting of four molecules of pyrrole linked 

by α-methylene bridges (protoporphyrin IX) to which is bound iron in its 

ferrous state (Fe2+) 

 

 

 

 

 

 
 

 

 

 
Fig 3.1(a) Polypeptide part of myoglobin                   Fig 3.1(b) Heme part of myoglobin 

 

3.1.1 Visualisation of oxymyoglobin using Jmol application 

PDB Code – 1MBO (Oxymyoglobin) 

          Link for accessing the PDB file -   https://www.rcsb.org/structure/1mbo 

1. Open Jmol version 16.1.11 using Jmol.jar 

2. Go to “File” in the main menu → Click on “Get PDB” →Type 1MBO → 

Structure of oxymyoglobin gets loaded onto the screen. 

https://www.rcsb.org/structure/1mbo
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3. Open the console by clicking on the “file” in the main menu 

4. Type the command $hide solvent (to hide the solvent atoms) 

5. Right-click and select “style” →Scheme→ Choose “trace” 

6. Open the console window and the command $color teal is written. 

7. Give the command $select HEM to select the heme part of myoglobin 

8. Right-click and choose “style”→ 

“Scheme”→ “Ball and stick” which  

     shows the heme ring in a ball and  

      stick fashion.          

9.  To view the oxygen atoms bound to  

the heme, Right click and click on   

“Select” → “Hetero” →” By 

HETATM” → “Oxygen molecule”    

                                                                   Fig 3.2 Structure of oxymyoglobin molecule                                                        

10.  Open the console window and type the command $spacefill;color yellow, and the 

oxygen bound to the heme part is shown beside. 

11.  To Change the background color, Right click and choose “file” → “color” → 

“Background” → “white” 

3.1.2 Ramachandran Plot for Oxymyoglobin 

To obtain the Ramachandran plot for the 

oxymyoglobin, Open the console window by 

right-clicking and typing the command 

$rama 

 

 

 

 

 

Fig 3.3 Ramachandran plot of oxymyoglobin with            Fig 3.4 Oxymyoglobin molecule made 

   75% of the amino acid residues in the                               up of 75% right-handed alpha 

    3rd quadrant.                                                                     helices corresponding to the plot.                                                                                       



9 
 

From the Ramachandran plot, it is evident that 75% of the amino acid residues are in 

right-handed alpha helices as the population in the third quadrant of the population is 

high. 

To view some particular amino acid residue (say the distal histidine[his64] and 

proximal histidine [hi93]) in the Ramachandran plot, type the command $display 

his64,his93 

 

Fig 3.5 The position of the proximal histidine (his93) and the distal histidine (his64) in the 

Ramachandran plot of oxymyoglobin PDB ID:1MBO 

 

3.2 Hemoglobin – The Oxygen Carrier 

Hemoglobin is a tetrameric protein that has a vital role in the transport of oxygen from 

the lungs to the tissues and bringing back carbon-di-oxide and is present in the 

erythrocytes.  

Hemoglobin consists of 

1) Four Polypeptide chains – Two alpha chains (Chain A and C in PDB codes 

1A3N and 1HHO) with 141 amino acid residues in each and two beta chains 

(Chain B and D in PDB codes 1A3N and 1HHO) with 146 amino acid residues 

in each. 

2) Heme group – Protoporphyrin ring bound to iron in its ferrous state (Fe2+). 
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The Hemoglobin permits cooperative interaction in the presence of an oxygen 

molecule and becomes dimeric. This phenomenon is crucial for its biological action. 

3.2.1 Viewing the sequence of alpha and beta chains of 

oxyhemoglobin using UCSF Chimera 

PDB Codes: 1HHO (oxyhemoglobin) 

Source links: https://www.rcsb.org/structure/1HHO 

1. Open UCSF Chimera 1.17.1 

2. Click “Fetch” → Select “PDB” Database→Enter 1HHO 

3. Click on “Favourites” in the main menu and select “Sequence” 

4. Choose the chain needed to be sequenced and click show. 

Fig 3.6 Sequence and position of amino acid residues in Chain A and Chain B of oxyhemoglobin 

5. The sequence of amino acids appears in one letter code. 

6. The sequences highlighted in yellow are those present in the right-handed 

alpha-helices of the tertiary oxyhemoglobin structure. 

 

3.2.2 Conformational changes by oxygenation of deoxyhemoglobin 

using UCSF Chimera. 

1. Open UCSF Chimera 1.17.1 

2. Fetch by PDB ID “1A3N” to open deoxyhemoglobin. 

3. In the main menu, Click “Tools” → “Structural analysis” → “Metal geometry” 

4. A window appears, Click the box “Depict idealized geometry” on the right side 

of the window. 

                         

https://www.rcsb.org/structure/1HHO
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Fig 3.7 The window shows the coordination of Iron in the heme part of Chain A with the four 

nitrogens present inside the heme ring (NA, NB, NC, ND) and the nitrogen on the proximal histidine 

(his87). 

 

 

 

 

 

 

 

 

 

     Fig 3.8 Images depicting the square pyramidal geometry of a deoxygenated heme (T-state) 

 

1. To open the oxyhemoglobin, click “File” → “Fetch by ID” → PDB Id “1HHO” 

is used. 

2. Choose “tools” → “Structural analysis” → “Metal Geometry” 

3. A window appears, Click the box “Depict idealized geometry” on the right side 

of the window. 
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     Fig 3.9 Images depicting the octahedral geometry of oxygenated heme (R-State) 

 

 

 

 

 

 

 

 

 

Fig 3.10 The window shows the coordination of iron with the four nitrogens in the heme ring, 

one nitrogen in the proximal histidine, and with the oxygen molecule. 

 

  

 

 

 

  

 

 

 

Fig 3.11 A and B depict the movement of the iron atom into the plane of the heme ring on 

oxygenation. 
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3.2.3 Measuring the distance of distal histidine from the iron atom in the 

oxyhemoglobin and deoxyhemoglobin using the Jmol application. 

1. Open Jmol using Jmol.jar  

2. Get PDB 1A3N by clicking on the file in the main menu. 

3. Open the console and write the command $delete solvent 

4. Right-click and select “style” → Scheme→Choose “trace” 

5. To choose only one beta chain (say Chain B), Open the console window and 

give the command $hide :a,:c,:d 

6. To color write the command $color darkslateblue 

7. In the console write $select HEM 

8. Right-click and choose “style” → “Scheme” → “Ball and stick” 

9. In the console window, give the command $select his63:B, his92:B 

10.  Right-click and choose “style” → “Scheme” → “Ball and stick”. This shows 

the proximal and distal histidines in chain B. 

11.  To measure the distance between the Nitrogen atom in the distal histidine and 

the iron atom, Right click and choose “measurements” → “Distance using 

angstroms”. 

12.  Now zoom in near the heme part and drag a line between the iron atom and 

his63:b.NE2 

13. The distance is found to be 4.22Ă 

14.  To save the file, right-click →file→save → Save script with state. 

15.  Similarly, the distance between the iron atom and his63:b.NE2 is found for 

oxyhemoglobin by loading the PDB Code 1HHO. 

16.  Additionally, write the command $select oxy; spacefill; color mediumvioletred 

to view the bound oxygen. 

17.  The distance is found to be 4.19Ă 

18.  To turn on the label, Write the command $select his63:b.ne2; label on 

From the above two values it could be concluded that in the presence of the 

dioxygen molecule, the distance between the distal histidine and iron atom is 

reduced by 0.03Ă. 
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                                                  . 

 

 

 

     

 

 

 

Fig 3.12 The image shows the distance between         Fig 3.13 The image shows the distance between 

the iron and distal histidine as 4.22Ă in                         iron and distal histidine as 4.19Ă in 

deoxyhemoglobin.                                                          oxyhemoglobin. 

                                                                                   

3.3 Sickle Cell Anemia 

Sickle-cell anemia is an autosomal 

recessive genetic disorder that arises due 

to a point mutation in the Hb Gene of 

Chromosome 11. The polar glutamic acid 

present in the 6th position of the beta chain 

of hemoglobin is negatively charged at 

pH=7.4 (at Blood pH) and is replaced with 

non-polar valine residue in the condition  

of sickle cell anemia. The presence of 

non-polar valine residue forms a 

hydrophobic “sticky patch”.  

                                                                     Fig 3.14 Mutation resulting in sickle cell anemia 

A person with sickle cell anemia has a large number of immature erythrocytes that are 

sickle-shaped. Both the normal Hb and Sickle Hb contain a complementary sticky 

patch on their surfaces that is exposed only in the deoxygenated, R state. Thus, at low 

PO2, deoxyHbS can polymerize to form long, insoluble fibers. 
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PDB Code: 2HBS (Sickle Hemoglobin) 

Link to access the PDB File: https://www.rcsb.org/structure/2HBS 

 

3.3.1 Overlapping the deoxyhemoglobin and sickle 

deoxyhemoglobin using UCSF Chimera 

1. Open Chimera 1.17.1 

2. Fetch by PDB ID 2HBS 

3. In the main menu, select “Favourites” → “Command line” 

4. In the command line type the following commands, delete solvent, delete :.a 

delete :.c delete :.d delete :.e delete :.f delete :.g delete :.h 

5. The Chain B of deoxy sickle hemoglobin is visible on screen 

6. Type the command open 1a3n to load the structure of Normal deoxyhemoglobin. 

7. In the command line type the command, delete solvent, delete :.a delete:.c 

delete :.d 

8. Go to “tools” in the main menu → “Structure comparison” → “Matchmaker” 

→ A pop-up window appears, select the Normal deoxyhemoglobin (1a3n) as 

reference structure and click “apply”. 

 

 

 

              

 

 

 

 

 

 

 

 

 

Fig 3.15 The image depicts the overlapping of Chain B of Normal deoxyhemoglobin and Sickle 

deoxyhemoglobin. 

https://www.rcsb.org/structure/2HBS
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9. Now to see the change in the sequence, click “Tools” in the main menu → 

“Structure comparison” → “Match” → “Align” 

10.  Select both the chains in the pop-up window and click “apply” 

11.  A window showing the sequence and position of amino acids appears. 

12.  From this, it is evident that there is a change in only one amino acid at position 

6. 

13.  Select E in the 6th position of 1a3n (Normal Hb) on the pop-up window and in 

the menu “Actions” → “color” → “hot pink” 

14.  Similarly, select V in the 6th position of 2hbs (Sickle Hb) and in the menu 

“Actions” → “color” → “yellow”  

 

 

 

 

 

 

 

  

 
 
 
 
 
 

 

Fig 3.16 The Valine residue in the 6th position of Sickle Hemoglobin (highlighted yellow) and 

the glutamic acid residue in the 6th position of Normal Hemoglobin (highlighted pink) 

 

 
 

           Fig 3.17 Sequences of Chain B of Normal Hemoglobin and Sickle Hemoglobin 

 

6th position of Beta Chains of 

Normal Hb and Sickle Hb 
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Chapter 4 

Construction of Jmol integrated webpage in 

                               Windows machine 

1. Download the code files from 

https://spokentutorial.org/watch/Jmol+Application/Editing+the+ 

JSmol+Integrated+Web+Page/English/ 

2. Extract the Editing-the-JSmol-Integrated-Web-Page-Codefiles folder  

3. Move the jspage folder to the desktop 

4. Download the latest version of Jmol from 

https://jmol.sourceforge.net/download/ 

5. Extract the Jmol folder and move the Jmol-version no. folder to the jspage 

folder 

6. Install the latest Visual C++ Studio available on the link 

https://aka.ms/vs/17/release/VC_redist.x64.exe 

7. Install the Apache lounge from 

https://www.apachelounge.com/download/VS17/binaries/httpd-2.4. 

57-win64-VS17.zip 

8. Unzip the contents of httpd-2.4.57-win64-VS17  

9. Move the Apache24 file to the local disk C 

10.  Move VC_redist.x64.exe from the downloads to the Apache24 folder in the 

local disk C. 

11.  Open the file explorer options, click on “view” and unbox the “hide  

 extensions for known file extensions”. Click Apply and then click ok. 

12.  Run the command prompt as administrator by left-clicking 

13. Installation of Apache: 

c:\Windows\system32>cd .. 

c:\Windows>cd .. 

c:\>cd Apache24 

c:\Apache24\bin>httpd.exe -k install 

c:\Apache24\bin>httpd.exe -k start 

 “Allow access” if a Windows Defender firewall pop-up window opens. 

To Check the service has started: 

Open the web browser and search http://localhost/ 

A message “It works” appears on the window. 

 

https://spokentutorial.org/watch/Jmol+Application/Editing+the+JSmol+Integrated+Web+Page/English/
https://spokentutorial.org/watch/Jmol+Application/Editing+the+JSmol+Integrated+Web+Page/English/
https://jmol.sourceforge.net/download/
https://jmol.sourceforge.net/download/
https://jmol.sourceforge.net/download/
https://aka.ms/vs/17/release/VC_redist.x64.exe
https://aka.ms/vs/17/release/VC_redist.x64.exe
https://aka.ms/vs/17/release/VC_redist.x64.exe
https://www.apachelounge.com/download/VS17/binaries/httpd-2.4.57-win64-VS17.zip
https://www.apachelounge.com/download/VS17/binaries/httpd-2.4.57-win64-VS17.zip
https://www.apachelounge.com/download/VS17/binaries/httpd-2.4.57-win64-VS17.zip
https://www.apachelounge.com/download/VS17/binaries/httpd-2.4.57-win64-VS17.zip
http://localhost/
http://localhost/
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14.  To edit the path, open httpd.conf file in the conf folder of Apache24 

 

            using Notepad. 

15. Edit line number 236 as <Directory "C:/Users/Dell/Desktop/jspage"> and save. 

16.  Make a copy of the example.html and rename it as xyz.html 

17.  To edit the html file, open it in the notepad, Edit the title in line 12, and specify 

the Jmol version number in lines 13 and 14. 

18.  Edit the topic in line number 49. 

19.  The structures saved in the .pdb or .spt format can be loaded by editing line 

numbers 59, 80, and 99. 

20.  The description for structures 1,2 and 3 can be added by editing Lines 122, 

128, and 134 respectively. 

21.  Edit the file names in lines 121, 127, and 133 with respective structure files. 

22.  Open the constructed web page in the browser by typing in the search bar 

jspage/xyz.html 

Note: Opening by double-clicking on the edited HTML file may not open up the 

.mol files and it is preferred to open by the above-said way. 

Link to the webpage constructed for globins 

https://drive.google.com/drive/folders/18c131Hh2RPAVugc3Ql4gjpCHJQxAa

9YY?usp=drive_link 

 

 

 

 

 

 

 

 

 

 

https://drive.google.com/drive/folders/18c131Hh2RPAVugc3Ql4gjpCHJQxAa9YY?usp=drive_link
https://drive.google.com/drive/folders/18c131Hh2RPAVugc3Ql4gjpCHJQxAa9YY?usp=drive_link
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Chapter 5 

           Active site interactions in Chymotrypsin 

5.1 Introduction 

Chymotrypsin is a serine protease that is present in the digestive systems of many 

organisms. It is a vital component in the pancreatic juice. Chymotrypsin is activated 

from its inactive zymogen (chymotrypsinogen) form by the enzyme trypsin. 

Inhibitors for this enzyme are synthesized and used to study its active site and 

ligand-enzyme interactions. 

A large number of chymotrypsin-inhibitor complexes are crystallized and their 

structures are analyzed.                                                                                         

 

 
 
 
 

 

       Fig 5.1 Chymotrypsin - trifluoromethyl                Fig 5.2 Chymotrypsin - Eglin C  

                    ketone inhibitor complex.                                     inhibitor complex. 

                     (PDB ID - 7GCH)                                                 (PDB ID - 4H4F)  

There are certain inhibitors that bind to the enzymes irreversibly, such inhibitors are 

called suicide inactivators. Amino acids with key catalytic functions in the active site 

can sometimes be identified by determining which residue is covalently linked to an 

inhibitor after the enzyme is inactivated. 

 

 

Fig 5.3 The reaction of chymotrypsin with 

diisopropylfluorophosphate (DIFP) irreversibly inhibits the 

enzyme. This has led to the conclusion that Ser195 is the 

key active-site Ser residue in chymotrypsin. 
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   Fig 5.4 Chymotrypsin with diisopropylfluorophosphate (DIFP) inhibitor (PDB ID 1DFP) 

 

5.2 Study of contacts of the enzyme-inhibitor complex 

using Jmol. 

1. Open Jmol using Jmol.jar 

2. Get PDB 7GCH by clicking the file option in the main menu. 

3. The Structure of Chymotrypsin-trifluoromethyl complex appears on the screen. 

4. Right click → Style → Scheme → Cartoon 

5. Open the console and type the command $color grey to change color. 

6. Again, type the command $select ligand; wireframe; color cpk 

7. The command $contact{ligand}to view the points of contact of the inhibitor 

with the enzyme’s active site. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

                                                                                                                           (b) 

                                                                                              Fig 5.5 (a) and (b) denote the interaction  

                                                                                                            of trifluoromethyl ketone with               

(a)                                                               chymotrypsin. (PDB ID -7GCH) 
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5.3 Viewing the hydrophobic pockets in Chymotrypsin 

using Jmol. 

1. Open Jmol using Jmol.jar 

2. Get PDB 7GCH from the file option in the main menu. 

3. Right-click → “Style” → “Scheme” → “trace” 

4. In the console window, type the command $color grey 

5. Give the command $select ligand; wireframe; color cpk to view the 

inhibitor. 

6. In the console, $isosurface select{protein}only pocket cavity vdw command 

is written to view the hydrophobic pockets present in the enzyme 

chymotrypsin. 

7. The inhibitor bound to a deep hydrophobic cleft of the enzyme is also seen. 

                                                         

 

 

 

 

 

 

 

 

 

 

                                                                                                                      5.7 (a) 
 

 

 

                              Fig 5.6   
The hydrophobic pockets present in the enzyme  

chymotrypsin (PDB ID 7GCH) 

 

 

 

 

 

Fig 5.7 shows the hydrophobic pocket where the inhibitor 

trifluoromethyl ketone binds to chymotrypsin. (a)top 

view and (b) side view of the hydrophobic pocket. 

 

 

 

 

                                                                                                                      5.7 (b) 
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Conclusion: 

In this project, Jmol and UCSF Chimera software were used to study the secondary 

and tertiary structures of Globular proteins such as Hemoglobin, myoglobin and 

Hydrolases such as Chymotrypsin and trypsin. Ramachandran plot for the proteins is 

also plotted. The sequencing and position of amino acids is determined using UCSF 

Chimera. The software is also used to visualize the geometry of the central atom. Jmol 

is one of the excellent tools to visualize the hydrophobic pockets present in the 

enzyme. The points of contact of the ligand-enzyme complex can be viewed using the 

script commands. Both Jmol and UCSF Chimera are powerful tools in the structural 

studies of proteins; they could be employed by teachers for interactive learning 

sessions for a deep understanding of concepts 
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